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Using the Manual
The description of the RWIND Simulation program is organised in chapters which follow the
common procedure for defining data, calculating, and evaluating results. They help to better
understand the functioning of the software. The specifications of some general functions can also
be found in the manual of the RFEM program .
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1
1.1

Introduction
Program RWIND Simulation
RWIND Simulation is an outstanding tool for creating wind-induced loads on general structures. The
RWIND Simulation application represents a separate program which is used externally to determine
load cases and wind loads for RFEM or RSTAB models. As for RFEM, the model may consist of beams,
surfaces, and/or solids in any composition. For RSTAB models, loads can be created for models that
fully conform to the structural system, such as lattice towers or braced girders without cladding.
RWIND Simulation uses a CFD (Computational Fluid Dynamics ) numerical model to apply a fluid
mechanics simulation of the flow around objects within a wind tunnel. As a result of the simulation
process, specific wind loads are created for RFEM or RSTAB.
For the simulation, a 3D mesh of finite volumes is used. RWIND Simulation performs an automatic
meshing, while the overall mesh density as well as the local mesh refinement near the model can be
easily set using just a few parameters. For the calculation of the air flow and the surface pressure on
the model, a finite volume numerical solver for incompressible turbulent flow is applied. The results are
then extrapolated on the model. RWIND Simulation has been designed to work with various numerical
solvers. Currently we recommend using the OpenFOAM ® software package, which according to
our tests gives very good results and is a widely used tool for CFD simulations. Alternative numerical
solvers are under development.
RWIND Simulation is able to read the topology from RFEM or RSTAB models or from external *.stl
and *.vtp files (importing *.ifc, *.stp and *.igs files is in preparation). Minor corrections of the model
concerning corners or joints may be required, but this is done automatically. The data relevant to the
loading can be defined either in RWIND Simulation or in RFEM/RSTAB where a separate window is
available. The latter option is recommended: It enables you to create load cases at equidistant angles
and to apply velocity profiles according to specific standards. Effects of turbulence can be included
optionally. The dimensions of the wind tunnel are set to the size of the model but can be modified, if
necessary.
The results of the simulation include the pressure and velocity fields around the model, the streamlines,
as well as the surface pressure and the member forces. They represent the results of a stationary
analysis. All results are illustrated by means of colormaps (isobands) or isolines on the model or by
slicer planes within the wind tunnel, respectively. The streamlines can be displayed in an animated
view, which makes it easy to evaluate the effects of laminar and turbulent flow. As an essential result of
the simulation, loads are created for the RFEM/RSTAB. They are exported to the respective load cases
where they are applied as FE nodal loads or member loads. To check the surface loads resulting from
the velocity profile, a special feature is available to display the load distribution in one of the global or
local directions.
The common procedure for creating wind loads with RWIND Simulation is as follows:
Define the model data in RFEM or RSTAB.
Open the Simulate and Generate Wind Loads window in RFEM/RSTAB. Define the wind directions
to create the corresponding load cases and specify the wind load parameters to be applied.
Use the [Open in RWIND Simulation] function to export the model data relating to one of the load
cases to the RWIND Simulation program.
In RWIND Simulation, you can review the settings of the wind tunnel, mesh, simplification of the
model etc. Adjust the parameters, if necessary.
Start the calculation in RWIND Simulation.
Check the results.
Quit RWIND Simulation and return to RFEM/RSTAB.
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Calculate the remaining load cases, if applicable.
Close the Simulate and Generate Wind Loads window. Then set the load case containing the wind
loads created by RWIND Simulation.
Inspect the imported loads in the work window and tables.
Combine the wind load case(s) with other load cases in load and result combinations, if applicable.
Finally, start the calculation of the deformations and internal forces.
Apart from the interactive application with RFEM or RSTAB, RWIND Simulation can be used a standalone program for universal CFD analyses. Simply import the model that you have created in your
CAD application and perform the analysis in RWIND Simulation. The flow fields, surface pressures,
drag forces, etc. can be exploited for various fields of application, such as an analysis of closely
spaced buildings or a pedestrian wind comfort simulation in a city.
We wish you a pleasant and successful time working with RWIND Simulation.
Your Dlubal Software team

1.2

RWIND Simulation Team
The following people were involved in the development of RWIND Simulation.

Program Coordination
Georg Dlubal, Dipl.-Ing.
Miroslav Šejna, Ph.D.
Jan Pušman, Mgr.
Luboš Pirkl, Ph.D.
Andreas Niemeier, M.Eng.

Programming
RWIND Simulation standalone program
Miroslav Šejna, Ph.D.
and PC-Progress s.r.o.
and CFD Support s.r.o.

RWIND Simulation interface in RFEM/RSTAB
Miroslav Valeček, RNDr.
Martin Budač, Ing.
Jan Štalmach, Ing.

Quality Management and Documentation
Andreas Niemeier, M.Eng.
Robert Vogl, Dipl.-Ing. (FH)
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1.3

Using the Manual
The chapters of this manual will guide you through the work with the RWIND Simulation and RFEM
programs. After a brief theoretical abstract in Chapter 2, detailed information on the input, calculation
and results topics is given in the following chapters.
In the text, the buttons are inserted directly in most cases. Alternatively, their descriptions are given in
square brackets, for example [View mode]. Expressions appearing in dialog boxes, windows, and
menus are set in italics to clarify the references.
In the PDF manual, you can use the full-text search with [Ctrl]+[f] to find specific expressions. If you do
not find what you are looking for, go to the Knowledge Base or FAQs on our website where you
can search for a solution of the problem.
British English and metric units are used in this manual. You can change the units any time to imperial
settings both in RWIND Simulation and in RFEM (see Chapter 'Units and Decimals' ).

1.4

Installation
The installation of RFEM is described in Chapter 2 of the RFEM manual . The system requirements
mentioned there also apply to the RWIND Simulation program. See FAQ 004176 for specific
hardware settings recommended for RWIND Simulation.
RWIND Simulation is available for download as an installation file on our website. Log on to your
Dlubal Account , and download the Trial Version of RWIND Simulation.
Before installing RWIND Simulation, close all applications running in the background.
For the installation, you must be logged on as administrator or have administrator rights. To work with
RWIND Simulation later, user rights are sufficient.

Installation Process
Launch the setup.exe file that you have downloaded.
Follow the instructions of the RWIND Simulation Setup.

Figure 1.1
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RWIND Simulation 1.x Setup dialog box
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When the installation has finished, start the program to complete the installation and to activate your
licence.

Figure 1.2

1.5

Message after installation

Licencing
To run the full versions of RWIND Simulation and RFEM, both programs must be authorised. This can
be effectuated by software or hardware keys in combination with your personal authorisation codes.
The authorisation process is described in Chapter 2.2.1 of the RFEM manual
Support and Services website of PC-Progress.

and on the

To activate RWIND Simulation, run the program as administrator. Select [Activate Now] in the dialog
box which appears when the program is started without a valid authorisation.

Figure 1.3

Activating RWIND Simulation

Then choose the way of activation in the Authorization Status dialog box. The most common option to
activate your Software key is [Activate on-line].

www.dlubal.com
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Figure 1.4

Authorization Status dialog box

For detailed instructions concerning the authorisation, see FAQ 003595 .

1.6

Starting RWIND Simulation
There are two options how to start RWIND Simulation. The program can be either launched directly or
applied indirectly from the RFEM or RSTAB interface.

1.6.1

Program RWIND Simulation

Double-click the RWIND Simulation icon on your desktop to start the program.

Figure 1.5

RWIND Simulation icon

When you open one of the model examples provided by the installation, the program window will
look as seen in Figure 'RWIND Simulation program' . The most important areas of the user interface
are tagged by their descriptions.

8

www.dlubal.com

1

Introduction

RWIND Simulation - User Manual

Figure 1.6

1.6.2

RWIND Simulation program

RFEM/RSTAB Interface

Open a model file in RFEM or RSTAB. Activate the Tools menu and then select RWIND Simulation Simulate and Generate Wind Loads.

Figure 1.7

www.dlubal.com

Opening RWIND Simulation interface in RFEM
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The Simulate and Generate Wind Loads window appears.

Figure 1.8
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Simulate and Generate Wind Loads window of RFEM
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2

Theory
RWIND Simulation is a computer program designed for wind flow calculations around buildings. The
software is capable to use external CFD codes to perform a CFD simulation and visualize
comprehensive engineering results of wind load acting on the surfaces of buildings.

2.1

CFD Solver
The current RWIND Simulation version recommends using the external CFD code OpenFOAM®. In
particular, a special, natively compiled OpenFOAM® version from CFD Support called
"OpenFOAM® for Windows", version 17.10 is utilised. The source code is based on the
OpenFOAM® version distributed via openfoam.org and is included within the installation of the
RWIND Simulation program.
The numerical solver is called "RWindSimulationSolver" and it is relative to the SIMPLE family of
solvers. The RWINDSimulationSolver is a steady-state solver for incompressible, turbulent flow, using
the SIMPLE (Semi-Implicit Method for Pressure Linked Equations) algorithm.
Since OpenFOAM® is distributed under the GNU GPLv3 licence, the RWINDSimulationSolver is
distributed under the same licence and its source code can be found in the RWIND Simulation
installation directory, subdirectory "OF\src". For more information about OpenFOAM®, visit the
CFD Support website or contact CFD Support directly at support@cfdsupport.com . Trademark
disclaimer: This offering is not approved or endorsed by OpenCFD Limited, producer and distributor of
the OpenFOAM software via www.openfoam.com , and owner of the OPENFOAM® and
OpenCFD® trade marks.
The result of the calculation is a three-dimensional field of velocity and pressure covering the entire
computational domain, i.e. the wind tunnel. Pressure values on the model boundary (exterior surfaces
of buildings) are then used to calculate the forces representing the wind load.
The methods used allow theoretically a very precise simulation of such flow, provided that the
computational mesh is sufficiently fine (e.g. tens of millions of mesh cells). However, such calculations
are very time-consuming and thus expensive. Furthermore, the preparation of such calculations, i.e.
topology clean-up and generation of an optimal mesh, often requires considerable effort and
experience. RWIND Simulation has thus been designed to be very easy to use and to get approximate
results on relatively coarse meshes in a very short time – typically within several minutes. If greater
accuracy is desired, the user can obtain more precise results by increasing the mesh density – the
capacity and performance of RWIND Simulation is limited only by the available memory and the
number of processors/cores used for the parallel calculation.

2.2

Computational Mesh and Model
Simplification
To generate a finite volume mesh, the model must be topologically correct. In RWIND Simulation,
model boundaries are defined by triangles, and the term "topologically correct" then means that these
triangles must form a closed triangular mesh, i.e. each mesh edge has exactly two adjacent triangles,
and that the triangles must not intersect or touch each other except common edges. In fact, the exact
definition of a "topologically correct" model is more complicated, but we don't want to go into all
details here.
The problem is that CAD models usually are not topologically correct – triangles of a 3D object often
intersect with triangles of another object, the model boundary is not closed, etc. The pre-processing of

www.dlubal.com
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such models for CFD analysis can be very extensive and require 60-80% of an engineer’s time.
Facilitating this work was therefore one of the main goals in the development of RWIND Simulation,
which has been achieved by implementing the so-called simplified model. The simplified model actually
represents a special mesh "shrink-wrapping" the original model. This mesh is topologically correct and
can be therefore used as a model boundary for the generation of a 3D finite volume mesh. The
simplified model will automatically correct most of the problems that would otherwise have to be
corrected manually. Those include:
Model simplification (see point 1 in Figure 2.1 ): Details that are not relevant to the given
simulation and could cause calculation instability due to insufficiently fine discretization are
simplified.
Intersection of triangles (see point 2 in Figure 2.1 )
Open edges and surfaces with zero thickness (see point 3 in Figure 2.1 )
Closing holes to prevent the air from flowing into the interior of the building (see point 4 in
Figure 2.1 )

Figure 2.1

12

Topological imperfections of CAD models
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Figure 2.2

Figure 2.2

shows some examples of automatically simplified models.

Simplified models

When simplifying the model, it is possible to specify the level of detail as well as the maximum size of
holes to be closed. Using a simplified model to determine the wind load on a building is based on the
following assumption: if the simplified model approximates the shape of the original model well, the
load calculated for the simplified model will also be close to the correct values.
Though we expect the use of a simplified model to be the most common choice, the user can turn off
this option and calculate with the model boundaries as they were imported. However, this option is
only recommended to advanced users experienced in CFD analyses.

www.dlubal.com
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2.3

Wind Speed Profile
Wind loads are climatic loads on buildings representing variable actions. They result from the pressure
distribution around the building which is subject to wind flow. In general, wind loads are applied as
surface loads acting perpendicularly on the surfaces featuring compression and suction effects.
The wind loads are regulated in specific standards, such as EN 1991-1-4 [1] or ASCE/SEI 7-16
[2] . In the Eurocode, the application area is specified for buildings with heights up to 200 m. This
limit may be increased to 300 m for wind profiles valid according to the German National Annex, for
example.
In the standards, the wind loads are converted into characteristic values so that the load capacity of
buildings can be determined. As those loads represent actions that vary over the time and the
geometry, their distinct stochastic characteristics is accounted for by those values.
For the design values, both the location of the building with its local wind climate and the surrounding
topography are essential. The wind climate is recorded in the standards by wind zone maps. In EN
1991-1-4 [1] , for example, the fundamental basic wind velocities are given. They represent average
values determined over the time when the wind takes effect. For detailed information on the wind
zones according to administrative borders, the Dlubal Online Services tool can be used to
comfortably obtain the values of the basic wind velocity, vb,0, and velocity pressure, qb.

Figure 2.3

Determining wind velocity with Dlubal Online Services tool

A Knowledge Base article describes in detail how wind loads on mono- and duopitch roofs are to
be considered according to EN 1991-1-4 [1] in Germany. In another Knowledge Base article ,
you can find an example how to apply wind on vertical walls.
The standards provide information on how to apply wind loads on buildings featuring mainly
rectangular shapes. RWIND Simulation, however, is able to determine the surface pressure and wind
velocities for building with any kind of shape. The fundamental (or mean) wind velocity can be applied
to determine the specific loads of a building – with or without interaction of other buildings – by a

14
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numerical wind tunnel simulation. If the wind velocity is defined individually for each level height of the
model, the simulation can also be carried out for standards other than EN 1991-1-4 [1] or
independently of any code.
The wind profiles described in EN 1991-1-4 [1] also account for the ground roughness. By the
character of the terrain, specific turbulence effects near the ground level and, thus, reduced velocities
are associated. EN 1991-1-4 [1] , Table 4.1 gives the corresponding terrain categories. Those
turbulence effects are different from the turbulences due to the shape of the building which are
described in the following chapter.

2.4

Turbulence
Turbulence is one of the most complicated phenomena observed in nature, making even its precise
definition difficult. Literature gives many definitions, as, for example, the one included in [3] : “A fluid
motion is described as turbulent if it is three-dimensional, rotational, intermittent, highly disordered,
diffusive and dissipative”.

Figure 2.4

Turbulence illustrated by streamlines on RWIND Simulation model

In order to fully capture the turbulence by numerical modelling, one has to solve the equations of
motion for fluid flow on all spatial and temporal scales. This approach is referred to as “direct
numerical simulation” (DNS). For industrial applications, the computational resources required by a
DNS far exceed the capacity of the most powerful supercomputers currently available.
Instead, RWIND Simulation uses a different technique where flow variables, such as velocity or
pressure, are decomposed into mean (averaged) components and fluctuating components. In other
words, governing equations of fluid motion are averaged in order to remove the small scales, resulting
in a modied set of equations that are computationally less laborious to solve. Those equations are
referred to as “Reynolds-averaged Navier-Stokes equations” (RANS).
In order to solve RANS in RWIND Simulation, the k–ε turbulence model [4] is used which
introduces two transport equations for the turbulence properties: the first one is the transport equation
of the turbulence kinetic energy k, and the second equation governs the transport of the dissipation rate
ε of k. This method represents the most widely used and tested model for CFD calculations. Robustness,
economy, and reasonable accuracy for a wide range of turbulent flows applications explain its
popularity in industrial flow simulations.

www.dlubal.com
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3
3.1

Input Data
Project Management
The model files created by the RWIND Simulation program are called “Projects”. The Project
Manager helps you to organise all projects.
To open the Project Manager, select File
the toolbar.

Project Manager on the menu or use the

button in

The Project Manager consists of two tabs in which the Project Groups and the contained Projects are
managed.

Project Groups

Figure 3.1

Project Manager, Project Groups tab

The first tab lists all project groups that have been created by the installation (“Demo”), by Dlubal
applications (“RFEM/RSTAB”) or by yourself. You can see the Description and Path of every project
group. The current project group is highlighted. To change the project group, double-click the relevant
line.
Use the [New] button to create a new project group. Specify the Name, Description and Directory of
the project group in a dialog box.

16
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Figure 3.2

New Project Group

Projects

Figure 3.3

Project Manager, Projects tab

The current project group is set as default. If necessary, you can select a different project group in the
list for the project to be allocated.
In the table, all projects contained in the current projects are listed. You can see their names,
descriptions, existing results, sizes and dates of modification. To sort the arrangement in a different
manner, click the corresponding table header.
Projects in the RFEM/RSTAB project group have special project (file) names, e.g.
"2DCB5BCB-58BA-4E63-B8B3-0F8772B1F44F.rws1". They are needed to identify projects
unambiguously. To make the projects table more user-friendly, ”Alias“ project names are displayed.
Do not change the original file names since this could cause inconsistent data exchange between
RWIND Simulation and RFEM/RSTAB.
Below, you see a preview of the selected project and its details.
To open a project, double-click it in the list. You can also select it and use the [Open] button.
Use the [New] button to create a new project. Specify the Name and Description of the project in a
dialog box.

www.dlubal.com
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Figure 3.4

New Project

The current project group is preset.
The Import model from file option enables you to import data by an interface. If you want to create the
model by yourself, however, clear this check box.
Click [Next] to open the following dialog box. It appears when a model is to be imported.

Figure 3.5

Import Model

When the Import model from file option has been selected, you can specify the file type the Import
Model dialog box. Currently RFEM/RSTAB data (file format *.vtp) and Stereo Lithography files (*.stl)
are supported.
Many 3D programs, such as Autodesk Revit, SketchUp, provide the option to export models to the STL
file format. RWIND Simulation can thus be used independently of RFEM or RSTAB to perform general
CFD analyses and determine the flow fields, surface pressures, drag forces, etc. of all sorts of models.
Load forces will not be created for RFEM/RSTAB, though.
Set the File path and the Length units. Make sure that the Z-axis is in accordance with the settings in
RFEM/RSTAB.
In the Options section, you can decide whether the model is to be moved to the origin. Furthermore,
the wind tunnel dimensions can be adjusted automatically to the size of the model.
Click [Finish] to import the model file.

18
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If the model is to be created in RWIND Simulation (instead of being imported from a file), clicking
[Next] in the 'New Project' dialog box opens the following dialog box.

Figure 3.6

Wind tunnel

You can define the dimensions of the wind tunnel by six parameters. The dimensions in X, Y and Z refer
to the origin. By default, the intake size is twice the width and height dimensions of the model. Its length
is set as three times the model length with a shorter distance at the intake side.
It is recommended to adjust the work plane grid to the size of the wind tunnel.
Click [OK] to create the new project and start working.
The Project Manager cannot be left open in the background as a stand-online application while you
work with RWIND Simulation.

www.dlubal.com
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3.2

Imported Models
At the present stage, models for RWIND Simulation can be created in RFEM or RSTAB, or imported
from an STL file (e.g. terrain and other objects). The wind loads applied in specific directions (see
description below ) result in corresponding load cases. Each direction represents one model in
RWIND Simulation. For the analysis, the models are exported to RWIND Simulation where the loads
are determined. After the calculation, the models are saved in the “RFEM/RSTAB” project group. The
denominations of each model (Project) include the names of the RFEM/RSTAB models and the load
case numbers.

Figure 3.7

RFEM models in Project Manager

You can open any RFEM or RSTAB model to examine the results. Additionally, you can modify the
calculation parameters, move or rotate the model or insert the geometry of the terrain (in development,
see Chapter 'Model Type' ).

20
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3.2.1

Wind Tunnel

You can modify the dimensions of the wind tunnel in a dialog box or graphically. To open the dialog
box, double-click the Wind Tunnel item in the Data navigator or select Wind Tunnel on the Edit menu.

Figure 3.8

Wind Tunnel dialog box

The size of the wind tunnel is defined by six parameters whose dimensions in X, Y and Z refer to the
origin. It is recommended to adjust the work plane grid to the size of the wind tunnel.
The [Adjust to Model] button enables you to reset the size to the default dimensions. [Adjust
Graphically] closes the dialog box and opens the feature described below.
To modify the wind tunnel graphically, click the Resize Wind Tunnel item in the panel. Make sure that
the Model tab of the work window is set.

Figure 3.9

Adjusting wind tunnel graphically

In the same way as described above, it is possible to enter the dimensions of the wind tunnel in the Edit
Bar panel. Additionally, you can modify its size in the work window by selecting one of the arrows and
moving it. The corresponding parameter are updated in the panel.
When you hold the [Shift] key while moving an arrow, the wind tunnel is modified symmetrically in the
respective direction. By holding the [Ctrl] key, you can scale the wind tunnel up or down uniformly in
all three directions.

www.dlubal.com
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The default dimensions of the wind tunnel are set as small as possible to obtain short calculation times.
If the simulation gives no convergence, one of the reasons may be that the length of the wind tunnel in
X-direction is too short, especially the area behind the object. In this case, you ought to extend the wind
tunnel accordingly.

3.2.2

Simulation Parameters

The parameters of the fluid dynamics analysis are managed in a dialog box containing several tabs.
You can open this dialog box by double-clicking the Simulation Parameters item in the Data navigator
or by clicking the Simulation Parameters item in the panel.

3.2.2.1

Figure 3.10

General

Simulation Parameters dialog box, General tab

Flow Parameters
The Inlet velocity represents the wind speed entering the wind tunnel. The value of the Kinematic
viscosity describes the resistance of the air to deformation. It is defined as the ratio of the viscosity to the
density of the air.
The surface roughness of the model is not considered by the simulation.

Finite Volume Mesh
The Mesh density to be applied around the model is controlled by percentual reference. This specific
refinement is utilised for the model simplification and the flow calculation. The default density (20%)
normally results in a relatively low number of finite volume mesh cells and a relatively fast calculation.
The minimum percentage is 10%. It entails a rather coarse mesh with the smallest number of volumes.
The higher the density of the mesh, the smaller the size of the finite volume cells will be. The results are
more precise accordingly, but the calculation will need more time due to the greater number of
volumes. Setting the maximum mesh density (100%) leads to very fine meshes with millions of volumes.
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The calculation of 3D flow on such meshes is on the edge of the capabilities of current PCs, with a
calculation time of several hours to several days.
You can enter the mesh density or modify it with the slider. The Mesh cell estimation below gives the
corresponding number of finite volume cells and the minimum cell size.
For further information, see Chapter 'Computational Mesh and Model Simplification' .
The Mesh refinement type can be defined for curvatures of the surfaces (fine mesh only close to sharp
edges of the model) or globally for a distance from the surfaces (fine mesh on entire boundary
surfaces). The first option is set as default because it produces meshes with a lower number of finite
elements.
The Snap to model edges option enables you to align the mesh with the borders of the model. Please
note that this option is only available when the model simplification is off.

Calculation
This dialog box section controls the parameters of the simulation. As Numerical solver, there is only
one option available at present. Alternative solvers are being prepared for upcoming program
versions. For more details on the OpenFOAM® solver, see Chapter 'CFD Solvers' .
Furthermore, you can define the Maximum number of iterations. This number does not mean that all
iterations have to be carried out factually: If the calculation converges with less iterations, it is stopped.
This number is useful to avoid infinite loops or apply short calculations for testing purposes.
The Convergence criterion represents the stop limit for the calculation. As soon as the residual pressure
has fallen beneath the defined value, the calculation is terminated. The diagram of iterations and
residual pressure is shown during the calculation. It is also available in the simulation results (see
Chapter 'Residual Pressure' ).

Figure 3.11

Diagram of iterations and residual pressure shown during calculation

If you activate the Use potential flow to calculate initial condition option, a linearised version of
non-viscous Navier Stokes equations is used to generate the start conditions.
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3.2.2.2

Figure 3.12

Turbulence

Simulation Parameters dialog box, Turbulence tab

In the second tab of the dialog box, you decide whether you want to Consider turbulence. The effects
of turbulent flow are characterised by chaotic changes of pressure and flow velocity (see
Chapter 'Turbulence' ), contrasting laminar flow. As the air represents a fluid with low viscosity,
excessive kinetic energy overcomes the fluid’s damping in areas with increased velocity.
The Model of turbulence can be based on the correlations between k and epsilon or k and omega.
The first option is set as default. Depending on the selection, you can specify either the turbulent
dissipation rate ε or the specific dissipation rate ω. In some cases, the simulation using kω is more stable
than the one using kε.
If you select the Calculate k-ε parameters from the intensity of turbulence option, you can define the
intensity I as percentage (ratio of root-mean-square of the turbulent velocity fluctuations and the
averaged velocity at the same location over some time period) in the text box below. The turbulent
kinetic energy k and the turbulent dissipation rate ε (or the specific dissipation rate ω, respectively) are
then determined by the program. Alternatively, you can define the parameters k and ε (or ω) manually
as soon as you have cleared the option mentioned above.
An idealised flow of air with absolutely no fluctuations in air speed or direction would have a
turbulence intensity value of 0%. For high-turbulence cases, the turbulence intensity typically is between
5% and 20% (see CFD online ). The turbulence intensity is set to 1% by default to cover most
medium- and low-turbulence cases.
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3.2.2.3

Figure 3.13

Wind Profile

Simulation Parameters dialog box, Wind Profile tab

This tab controls the parameters of the wind speed which is applied to the model. When the model has
been imported from RFEM or RSTAB, the wind profile in compliance with the selected standard is
shown.

Type of Wind Speed Values
You can define the wind speed as Relative or Absolute values. When you select the first option, the
reference value 1 corresponds to the Inlet velocity defined in the General tab. You can then define the
Factor of each height level in the table (see Section 'Wind Profile' below). When you select the
second option, you can enter the wind speed in that table. The table header is accordingly changed to
Speed.

Wind Profile
To define the wind speed at specific height levels in this table, enter the Number of rows required and
click [Apply]. Then you can define each Height and allocate the Factor (or Speed, depending on the
option selected above). Alternatively, paste the values of an Excel sheet. Click the [Refresh Chart]
button to display the Wind Profile diagram of your data.
The [Constant] button creates a uniform wind profile for the entire model. There are only two table
rows needed.
If you use the [Generate] button to create a wind profile, a new dialog box is opened.
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Figure 3.14

Generate Wind Profile dialog box

Define the height of the profile and the number of intermediate points. You can select between a
logarithmic and linear type of profile. Enter the height at which the inlet velocity (defined in the General
tab) is applicable. Finally, select the relevant landscape type to define the roughness of the terrain:
small towns and villages, large towns with high buildings, or large cities with skyscrapers. Then click
[OK] to generate the wind profile.
In the "RWIND Simulation window" of RFEM/RSTAB, you have advanced options to create wind
profiles according to specific standards (see Chapter 'Wind Load' ).

3.2.2.4

Figure 3.15

Info

Simulation Parameters dialog box, Info tab

After the simulation, the last tab contains information on the mesh and on the drag force sums of both
the original and simplified model. If there are major differences between those sums, it is advisable to
increase the level of detail (see Chapter 'General' below).
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Edit Model

3.2.3

You can modify some general settings of the model in a dialog box. To open that dialog box,
double-click the RFEM/RSTAB Model item the Data navigator or select Model on the Edit menu.
Alternatively, double-click the model in the work window.

General

3.2.3.1

Figure 3.16

Edit Model dialog box, General tab

Model Name
For imported models, the description RFEM/RSTAB Model is shown in the text box. You can enter any
description to characterise the model.

Model Type
Any model which you have imported from RFEM or RSTAB represents the Primary model. It includes all
objects of the Dlubal application where the wind is to be applied, such as surfaces, beams, solids, and
openings. Each project must have exactly one primary model. When generating wind loads for
RFEM/RSTAB, the primary model is always set to data imported from the Dlubal application.

Secondary model type

In addition to the primary model, the RWIND Simulation project can include other models that affect
the flow around the primary model. In practice, those secondary models represent surrounding
buildings or terrain, for example. Such models are to be imported from external files (*.stl). They can
then be conveniently placed by drag-and-drop operations, or be modified (rotated, moved or resized)
by using a dialog box or graphical manipulator (see Chapter 'Edit Objects' ).
The Terrain Model is a special type of secondary model that differs from other models in two things:
(a) It can be used as boundary condition, i.e. the bottom boundary of the computational domain.
(b) Drag forces are not calculated for this model.
If the project contains multiple models, the Drag Force Sum displayed in the legend of the work
window (see Chapter 'Sums of Drag Forces' ) represents the sum of the forces applied to all models
except for the terrain. The drag force for each individual model can be found on the Info tab of the Edit
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Model dialog box containing the properties of that model (see Chapter 'Info' ).

Figure 3.17

Terrain model used as boundary condition (imported from an STL file)

The "M_21BuildingWithTerrain" project in the Demo folder features an example of a terrain model.

Model Simplification
The Simplify model option is set as default. It means that small corrections of the RFEM/RSTAB model
required at e.g. boundaries or corners are done automatically by RWIND Simulation (see
Chapter 'Computational Mesh and Model Simplification' ). You can control the Level of detail of this
simplification to a specific level. Use the slide rule to modify it from 0 (very coarse modelling of details
with a wide mesh) to 4 (many details with a very fine mesh). The default value 2 represents a good
compromise between simplification of the model and calculation speed. Click [Apply] to view and
check the simplified model based on a new level of detail.
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Figure 3.18

Model with levels of detail 0 (top) and 4 (bottom)

As a guidance, the Detail size of the meshing is shown in the text box below.
The mesh is automatically refined around the model subjected to the wind flow, which contributes to
higher calculation efficiency.
Depending on the geometry of the model, it is not always possible to apply high levels of detail. Level
4 settings can slow down the program considerably or may cause insufficient memory errors.
The Close holes smaller than option enables you to control how holes in the model are to be treated.
0% is preset. That means that all openings or gaps are considered for the analysis. The level can be
modified as either percentage or absolute value in order to neglect small openings and simplify the
model. On the other hand, window or door openings which are closed in the real model can be easily
filled with this feature.
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Figure 3.19

House with closed openings

If a beam model represents the structural model of a framework whose surfaces (cladding or roof
covering) are not represented explicitly, those surfaces are not represented in the imported model of
RWIND Simulation either. As a matter of consequence, the wind load will be applied only to the
members, not to the surfaces lying in between. The Close holes function is not appropriate in this case
to replace the surfaces: loads on FE nodes would be created which cannot be exported to the beam
model. They would be missing in the framework.
As the automatic recognition of openings is a demanding topological task, it may be required to adjust
openings manually.
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3.2.3.2

Figure 3.20

Position

Edit Model dialog box, Position tab

In this tab, the Transformation of the RFEM/RSTAB model is specified. The parameters of displacement
(dX,dY, dZ) and rotation (A1, A2, A3) refer to the origin defined in the Dlubal application, considering
the wind direction of the relevant load case and the size of the wind tunnel.
The Scaling options enable you to change the model size in one or more directions. S1 is the axis in
the wind direction, S2 transversal to it, while S3 represents the vertical axis. If you want to scale the
model uniformly in all directions, select the Lock aspect ratio option.
In a similar way, the Skewing parameters enable you to distort the model. K1 is the axis in the wind
direction, K2 transversal to it, while K3 represents the vertical axis for rotation.
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3.2.3.3

Figure 3.21

Info

Edit Model dialog box, Info tab

The last tab contains information on the dimension of the model and on the mesh. After the calculation,
the drag force sums of both the original and simplified model is also listed.

3.2.4

Repair Model

RWIND Simulation is able to correct small discrepancies within the model, such as nodes located very
close to other ones. To apply this function, select Repair Model on the Edit menu. Those corrections
may only be required when using non-simplified models. Simplified models do not need to be repaired
this way.

Figure 3.22
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Model Information
In this dialog box section, you can review the number of points, cells, open edges and non-manifold
edges. When you click the [Repair model] button, those numbers will change, depending on the
geometry of the imported model: the improved model will have less points and open edges.

Parameters
The Tolerance for merging points controls the limit spacing for close points. If the tolerance is below this
value, the points will be merged to a single one.

List of Corrections
There are three options in this dialog box section to control which items are to be improved: points
and/or mesh. It is recommended to select every one of them.
As mentioned above, the [Repair Model] function tries to improve the model layout. Those modification
will not yet be effective for the model, however. You can try different limits and check on the Model
Information. When you are sure to adopt the changes, click [OK] or [Apply].

3.2.5

Edit Objects

When the Model view is set, the panel provides some options to modify the position of the model. It
can be moved, rotated or resized.

Figure 3.23

Edit Objects options in panel

You can also access those functions on the Edit menu.
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3.2.5.1

Figure 3.24

Orient Primary Model

Model Orientation dialog box

You can modify the Rotation angle to adjust the orientation of the model towards the wind inlet. A
positive value rotates the model about the positive direction of the global Z-axis.
The dimensions of the wind tunnel are adjusted automatically to the rotated model when you have
selected the corresponding option. In the work window, you can check on the rotation angle when you
have selected the dynamic update option.

3.2.5.2

Manipulate Model

Select the model before applying the function.

Figure 3.25

Options to manipulate Position and Rotation in panel and work window

You can modify the Position and/or Rotation of the model either numerically by entering the values in
the text boxes or graphically by using the arrows shown around the model. The parameters of
displacement (pX, pY, pZ) and rotation (A1, A2, A3) refer to the axes defined by the wind tunnel: pX
and A1 are the coordinates or angles in wind direction, pY and A2 the ones transversal to it, while pZ
and A3 represent the vertical coordinate or angle.
When the Local CS option is selected, all axes refer to the coordinate system of the original model of
RSTAB/RFEM. If the model is derived from load case “Wind 90°”, for example, the coordinate system
will be rotated by 90°.
Alternatively, you can move or rotate the model in the work window by selecting one of the arrows
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and moving it. The corresponding parameter is shown in the Current Value and Step box of the panel.
There you can also set some interval Δ for the model to snap on when moving the pointer. To
deactivate the graphical tool, click the empty space in the work window.
Click [Apply] to check in the graphics whether you have set the correct parameters. [Stop] or [Esc] will
cancel the function.
The wind tunnel is not adapted automatically to the new situation. Use the 'Wind Tunnel' dialog box
where you can adjust its dimensions to the new position of the model.

3.2.5.3

Resize Model

Select the model before applying the function.

Figure 3.26

Options to resize Dimensions in panel and work window

You can modify the Dimensions of the model either numerically by entering the values in the text boxes
or graphically by using the arrows shown around the model. The parameters of displacement (dX, dY,
dZ) refer to the axes defined by the wind tunnel: dX is the axis in the wind direction, dY the one
transversal to it, while dZ represent the vertical axis. If the dimensions are entered manually, the centre
of gravity is retained when resizing.
Please note that the axes refer to the original model of RSTAB/RFEM. If the model is derived from
load case “Wind 90°”, for example, the local coordinate system will be rotated by 90°.
Alternatively, you can resize the model in the work window by selecting one of the arrows and moving
it. The corresponding parameter is shown in the Current Value and Step box of the panel. There you
can also set some interval Δ for the model to snap on when moving the pointer. To deactivate the
graphical tool, click the empty space in the work window.
Click [Apply] to check in the graphics whether you have set the correct parameters. [Stop] or [Esc] will
cancel the function.
The wind tunnel is not adapted automatically to the new situation. Use the 'Wind Tunnel' dialog box
where you can adjust its dimensions to the new size of the model.
Be careful when manipulating models that have been imported from RFEM or RSTAB. The modified
sizes will not be exported back to the Dlubal application!

www.dlubal.com

35

3

Input Data

RWIND Simulation - User Manual

3.2.5.4

Graphical Manipulator

Select the model before applying the function.

Figure 3.27

Options to Transform Objects in panel and work window

The panel and the work window provide the previously described features for you to manipulate the
model: Translation or Rotation (see Chapter 'Manipulate Model' ), Scaling and Skewing (rotating
about an axis with changing coordinates of only one direction – see Chapter 'Resize Model' ).
Alternatively, you can modify the model in the work window by selecting one of the arrows and
moving it. The corresponding parameter is shown in the Current Value and Step box of the panel.
The wind tunnel is not adapted automatically to the modified model. Use the
'Wind Tunnel' dialog box where you can adjust its dimensions to the new conditions.
Be careful when manipulating models that have been imported from RFEM or RSTAB. The modified
sizes will not be exported back to the Dlubal application! To avoid model inconsistencies, manipulate
only models that you have imported from *.stl files for simulations independently of RFEM or RSTAB.

Drag-and-drop
Models can also by moved (or copied) by using drag-and-drop operations, which can sometimes be
easier than using the graphical manipulator.
The standard drag handle of a model is indicated by small sphere visible when the model is
preselected. When the [Alt] key is pressed, all available handles are displayed: Blue spheres at each
side of the model and small orange spheres at the position of the pointer. Select the most suitable one.
When dragging the model, release the [Alt] key. For the graphical pointer to snap to another model,
press the [Alt] key again. As soon as you have approached the target model, blue and orange help
points are displayed for a suitable placement, which allows for an easy alignment.
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Figure 3.28

Aligning objects during drag-and-drop

To copy a model, press [Ctrl] when dropping the model.
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3.3

User-Defined Models
In the current version of the program, it is not yet possible to create user-defined models. This feature
will be available in upcoming releases.

3.4

RFEM/RSTAB Window
At the present stage, models can only be created in the Dlubal applications RFEM and RSTAB whose
settings concerning the wind load simulation are to be defined in a specific window. Based on those
parameters, load cases are created which can then be analysed by RWIND Simulation.
To access the “RWIND Simulation window” in RFEM or RSTAB, select Tools
Simulation - Simulate and Generate Wind Loads on the menu.

RWIND

This function is available for 3D model types only.

Figure 3.29

Accessing the Simulate and Generate Wind Loads window in RFEM

Window Simulate and Generate Wind Loads opens which consists of three tabs.
Wind Load
Load Cases
Settings
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3.4.1

Figure 3.30

Wind Load

Window Simulate and Generate Wind Loads, Wind Load tab

In this tab, you can define the common parameters that are relevant to determine the wind load.
Chapter 'Wind Speed Profile'

gives you some general information on the application of wind loads.

Wind Directions
This tab section controls the wind directions which will affect both the wind exposure of the model and
the number of generated load cases. The angle φ to set the wind directions refers to the positive global
X-axis of the model. The rotation is defined clockwise about the positive Z-axis.
You can apply a Uniform division of the wind rose by equidistant steps Δφ. The finer the division steps
are, the more load cases will be created. Define the start angle φA (0° is aligned to X-axis) and the
end angle φB of the distribution.
Alternatively, you can apply Manually defined directions: enter the values of the angles and separate
them by semicolons. To save user-defined directions, click the
button and enter a description. Click
the
button to import a user-defined list of wind directions.

Wind Velocity
In this section, you can define the parameters of the wind velocity. There are two options.
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According to Standard
The wind load is determined over the height of the building, depending on the wind zone, terrain
category and altitude. At the present stage, only EN 1991-1-4 [1] is available. Select the National
Annex which is to be applied (see image to the left).
Select the Wind zone which is relevant to your National Annex. The
map showing the wind zone of your country.

Figure 3.31

button enables you to open a

Wind zones of the Netherlands

When you double-click some location in the map, the corresponding wind zone will be set in the list.
Select the terrain Category in the list. Depending on your National Annex, different categories are
available.
For some National Annexes, the wind velocity is also dependent on the Altitude HS of the terrain. The
value can be entered manually.
As a result of all parameters, the Fundamental wind velocity vb,0 is displayed. The wind profile is
calculated from this value, taking into account the model's overall height. According to EN 1991-1-4
[1] , 4.2, the fundamental wind velocity is the characteristic 10 minutes mean wind velocity,
irrespective of wind direction and time of year, at 10 m above ground level in open country terrain
with low vegetation such as grass and isolated obstacles with separations of at least 20 obstacle
heights.
You can review the wind velocities of every level both in the table below and the diagram to the right.
Instead of the fundamental wind velocity, you can Consider the mean velocity. According to EN
1991-1-4 [1] , 4.3, the mean wind velocity vm(z) at a height z above the terrain depends on the
terrain roughness and orography. It is determined according to EN 1991-1-4 [1] , Expression (4.3).
This accounts for the fact that effects of peak velocity pressure appearing on the model are considered
by a specific wind tunnel simulation, which allows for the application of lower mean velocities. When
this option is activated, both the table and the diagram are updated.
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The profiles of the mean velocities vm are specified in the National Annex for Germany, Table NA.B.2.
for the four terrain categories, for example.

User-defined
You can define any wind profiles not represented by EN 1991-1-4 [1] individually in a table sheet.
Enter the Level z and allocate the corresponding Wind Velocity. [Enter] creates a new table line for the
next level.
The [Import from MS Excel] button enables you to import a specific pressure curve from the active
Excel sheet.
The velocity diagram is displayed dynamically to the right.
The buttons below the table have the following functions.
Button

Function
Opens a dialog box where you can select a user-defined wind profile
Opens a dialog box where you enter a name for the current wind profile to save it
Exports the current wind profile to MS Excel
Imports a wind profile from MS Excel
Restores the default settings
Opens the Windows calculator where you can compute values

Table 3.1

Buttons for user-defined diagrams

Model Properties
The Close holes smaller than option enables you to control how openings are to be treated. By default,
all holes or open spaces are fully considered for the analysis performed by RWIND Simulation. This
means that openings that you have modelled for e.g. windows or doors are assumed as open surfaces.
To close those openings, you can enter their Absolute size as a limit. Alternatively, the value of that limit
can be defined as Percentage of the model size. Figure 'House with closed openings' shows the
result of that feature applied to the simplified model of RWIND Simulation.
Make sure to close the surfaces of imported beam models. Otherwise the wind load will be applied
only to the members.
As the automatic recognition of openings is a demanding topological task, it may be required to adjust
openings manually.
The Terrain level option controls which part of the building is exposed to the wind. The default value is
zero, which means that the lowest part of the model is accounted for. If the model contains a basement
storey or foundations, for example, the terrain level should be adapted accordingly. The value refers to
the orientation of the global Z-axis: if it points upwards, a positive value moves the model
downwards. If the Z-axis points downwards, however, you have to enter a negative value. The
terrain level represents a global value, i.e. it is not possible to define an inclined terrain.
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3.4.2

Figure 3.32

Load Cases

Window Simulate and Generate Wind Loads, Load Cases tab

The second tab of the Simulate and Generate Wind Loads dialog box gives you a list of the generated
load cases and their descriptions. The result depends on the wind directions that you have previously
defined in the Wind Load tab. If you have set a uniform, fully circular arrangement at angles of 45°,
for example, eight load cases are created as seen in the Figure above .
By default, the first free load case number is used as initial one. If necessary, use the 'Settings' tab
(see below) to set a different number for the first wind load case to be generated.
The Calculated column shows you whether results of RWIND Simulation are available (you need to
calculate a load case first, see Chapter 'Calculation in RFEM/RSTAB' ).
You can enter a Comment to each load case, for example to describe its parameters.
The [View Mode] button at the end of the table enables you to jump to the work window and check on
the directions of the wind loads. As described above, the angle φ refers to the positive global X-axis,
with a clockwise rotation about the positive Z-axis.
The functions [Calculate All in Background] and [Calculate LC in Background] are described in
Chapter 'Calculation in RFEM/RSTAB' . They will execute a “silent” analysis of all load cases or of
the selected one, respectively. The [Open in RWIND Simulation] button, however, calls up the RWIND
Simulation program. There you can view the model and its location within the wind tunnel. You can
also check whether the mesh settings are adequate (see Section 'Model Simplification' and
Section 'Finite Volume Mesh' ) and adjust the parameters, if necessary.
Before applying [Calculate All in Background], you should check on the transfer of the model and the
model simplification in RWIND Simulation. Calculate one load case and follow the progression of the
residual pressure. Then examine the plausibility of the results. It may be necessary to adjust the wind
tunnel, FE mesh, number of iterations, etc. When everything has been verified, the “blind” simulation of
all load cases in the background is acceptable.
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3.4.3

Figure 3.33

Settings

Window Simulate and Generate Wind Loads, Settings tab

Flow Parameters
These parameters control the dynamic behaviour of the fluid. The Density of the air is dependent on the
altitude, temperature, atmospheric pressure, and humidity. The value of the Kinematic viscosity
describes the resistance of the air to deformation. It is defined as the ratio of the viscosity to the density
of the air.

Calculation Parameters
The Density of mesh to be applied around the model is controlled by percentual reference. This specific
refinement is utilised for the model simplification and the flow calculation. The default density (20%)
normally results in a relatively low number of finite volumes and a relatively fast calculation. The
minimum percentage is 10%. It entails a rather coarse mesh with the smallest number of volumes. The
higher the density of the mesh, the smaller the size of the finite volume cells will be. The results are more
precise accordingly, but the calculation will need more time due to the greater number of volumes.
Setting the maximum mesh density (100%) leads to very fine meshes with millions of volumes. The
calculation of 3D flow on such meshes is on the edge of the capabilities of current PCs, with a
calculation time of several hours to several days.
For further information, see Chapter 'Computational Mesh and Model Simplification' .
The Maximum number of iterations does not mean that all iterations have to be carried out factually: If
the calculation converges with less iterations, it is stopped. That limit option can be useful to avoid
infinite loops or apply short calculations for testing purposes.
The Target residue represents the stop criterion for the calculation. As soon as the residual pressure has
fallen beneath that limit, the calculation is terminated.
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The Level of detail controls the simplification of the model in RWIND Simulation where specific
corrections of the RFEM/RSTAB model are required at e.g. boundaries or corners (see
Figure 'Model with levels of detail)' ). You can define levels of detail between 0 (very coarse
modelling of details with a wide mesh) to 4 (many details with a very fine mesh). The default value 2
represents a good compromise between simplification of the model and calculation speed.

Generated Load Case Properties
In this section of the dialog box, you can set the Number of the first load case to be created. By
default, the first unused number is set.

Turbulence Model Properties
For the calculation with RWIND Simulation, the effects of turbulence are essential. If you want to
Consider turbulence, activate this option. The effects of turbulent flow are characterised by chaotic
changes of pressure and flow velocity, contrasting laminar flow. For further explanation, see
Chapter 'Turbulence' .
The fluctuating component of the wind is represented by the Turbulence intensity defined in EN
1991-1-4 [1] , 4.4. It is the standard deviation of the turbulence divided by the mean wind velocity.
The recommended rules are given in EN 1991-1-4 [1] , Expression (4.7). You can define the
intensity I as percentage, i.e. the ratio of root-mean-square of the turbulent velocity fluctuations and the
averaged velocity at the same location over some time period. The turbulent kinetic energy k and the
turbulent dissipation rate ε (see below) are then determined by the program. An idealised flow of air
with absolutely no fluctuations in air speed or direction would have a turbulence intensity value of 0%.
For high-turbulence cases, the turbulence intensity typically is between 5% and 20% (see
CFD online ). The turbulence intensity is set to 1% by default to cover most medium- and
low-turbulence cases.
Alternatively, you can define the elevation-independent turbulence intensity by specifying the k-eps
parameters manually. The Turbulence kinetic energy represents the mean kinetic energy characteristic
for eddies which is produced by fluid shear or friction. The Rate of dissipation of turbulence energy
describes the deduction of energy due to the airflow. For detailed information on turbulence kinetic
energy, see CFD online .

Member Load Distribution
The settings of this window section have an effect on the load application of the generated member
loads on the model.
Concentrated: The loads result in concentrated loads at relative distances along every member. The
intervals of the load application points are usually very small, depending on the density of the mesh.
Uniform: For every member, constant loads are created along the member length. Only one uniform
member load applied for each global direction.
Trapezoidal: Similar to uniform loads, the concentrated loads are levelled along the member. They
are converted to a trapezoidal distribution, however, to approximate the actual gradients.
In many cases, the Uniform distribution is accurate enough.
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Figure 3.34

Result of three options for column member (concentrated, uniform, trapezoidal from left to right)

General
The Export optimized member topology option is enabled by default. It means that member elements
are converted to simplified sections in the model of RWIND Simulation. Every cross-section is replaced
by a rectangular section which encompasses the outlines of the original one. By this simplification, the
simulation can be performed much faster as the meshing of the member is less detailed. For further
details, see FAQ 004165 .

Figure 3.35
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Optimised member topology (left) versus original topology (right)
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4
4.1

Calculation
RWIND Simulation
When you have used the [Open in RWIND Simulation] button in the Simulate and Generate Wind
Loads window of RFEM or RSTAB, the RWIND Simulation program is started. You see the model and
the wind tunnel in the work window. Before you start the simulation, you ought to check whether the
parameters applied to the CFD analysis are convenient.

4.1.1

Checking Parameters

Wind tunnel
The outline of the wind tunnel is displayed as a box around the model in its centre. You can check on
the wind direction which is symbolised by a big red arrow. In the View navigator, several options are
available to display some items relevant for the wind tunnel (see figure to the left). The terrain level
results from the value defined in the Model Properties section of the General Data window.
If necessary, you can adapt the size and position of the wind tunnel graphically or in the Wind Tunnel
dialog box (see Chapter 'Wind Tunnel' ). Make sure that enough space is provided at all sides of the
model for the air to flow unimpededly.

Holes
If you have selected the Close holes option (see Section 'Model Properties' ), you can check whether
the holes are adequately closed in the model of RWIND Simulation. If necessary, you can modify the
settings in the 'Edit Model' dialog box of RWIND Simulation. Note that it will make a considerable
difference for the analysis whether the air can flow through an opening or not.

Simplified model
RWIND Simulation features a Simplified Model which is created from the original RFEM/RSTAB
model. It represents a special mesh to define the model boundary (see
Chapter 'Computational Mesh and Model Simplification' for further information).
You can display the simplified model as follows:
Select the Show Simplified Model option in the panel.
Select the Simplified option in the View navigator for the Model display.
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Figure 4.1

Options to display simplified model in View navigator and panel

The degree of simplification is controlled by the Level of detail specified in the
'Edit Model' dialog box . Chapter 'General' includes two examples on how this value is accounted
for the simplified model. If the boundaries are not reflected properly, you can adapt the level. When
you click [Apply] in the 'Edit Model' dialog box , you can immediately check on the modifications
and view the new simplified model. Note that a very detailed modelling will accordingly require
computational time.
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4.1.2

FE Mesh

As described in Chapter 'Computational Mesh and Model Simplification' , two types of meshes are
used for the simulation. The simplified model is “shrink-wrapped” by a mesh of the boundaries which
again provides the basis of the 3D volume mesh around it. The former represents the so-called Surface
Mesh, the latter the Volume Mesh.
When the calculation of results is started (see Chapter 'Calculation' ), the mesh is created
automatically. To create the mesh separately, however, select Generate Mesh on the Simulation
menu.
The panel provides specific options to display the two types of meshes.

Show Surface Mesh

Figure 4.2

Surface mesh of model

Select this option to check whether the Mesh Density set in the 'Simulation Parameters' dialog box
gives an adequate representation of the original model. Furthermore, the Level of Detail set in the
'Edit Model' dialog box strongly influences the quality of the surface mesh. If the simplified model
appears too coarse or extremely fine, you ought to modify the level of detail.
In the View navigator, you can control the display of Mesh Faces (the filled mesh surfaces) and Mesh
Edges (separation lines between mesh elements) – see Figure 4.1 .
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Show Volume Mesh

Figure 4.3

Volume mesh of wind tunnel

The volume mesh is displayed in a so-called Slicer plane. It represents a section through the wind
tunnel which is parallel to one of the global planes (XY, YZ, XZ). For more information on handling the
slicer, see Chapter 'Slicer' . You can identify the refined volume mesh at the model boundaries and
the wider mesh at distant locations.

4.1.3

Calculation

Start Calculation
In the RWIND Simulation program, you can start the calculation with the following options:
Select Start Calculation on the Simulation menu.
Select Calculate Results in the panel.
You can follow the progression of the mesh generation and calculation in the panel.
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Figure 4.4

Progression of calculation shown in panel

The simulation iteratively determines the Residual Pressure until the either the convergence criterion is
satisfied or the maximum number of iterations is reached. Those limits are controlled by the Simulation
Parameters settings (see Chapter 'General' ).
The Residual Pressure diagram is also available after the calculation (see
Chapter 'Residual Pressure' ).

Stop Calculation
You can interrupt the simulation at any time by clicking [Stop Calculation], for example to obtain the
results at a specific residual pressure, or when there is no convergence. The results are then created for
the current iteration (i.e. the next iteration after the interruption) and will be available for evaluation.
To proceed with the calculation, click [Continue Calculation] in the panel. This function is also
available when the simulation was accomplished regularly. In the Continue Calculation dialog box,
you can then specify the new limit of iterations and/or convergence criterion.

Figure 4.5

Continue Calculation dialog box

This means that you can interrupt the calculation at any time, look at the intermediate results and
continue the simulation if you wish. You can also increase the number of maximum iterations if the
calculation was finished without having reached the stated residual. Note that the Continue Calculation
function is not available after having closed the project.
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If the [Stop Calculation] function does not terminate the calculation within 30 seconds, the text of the
button is changed to [Cancel Calculation]. You can then use this button to abort the simulation. The
Cancel Calculation function is also available on the Simulation menu. It terminates immediately all
running calculation processes and deletes the temporary files. No results will then be available.

Show Log Files
All calculation steps are recorded in a log file. To open this file, click the [Show Log Files] option which
is available in the Display Options of the panel or on the Simulation menu. The Log Files dialog box
appears where you can check on the details of each calculation step. If the calculation is running, the
dialog contents and log files are updated, while the other GUIs (e.g. Edit bar in the main window) are
updated only after the dialog box is closed.

Figure 4.6

OpenFOAM Log Files dialog box

Notes
The calculating time largely depends on the global Mesh Density (see
Chapter 'Simulation Parameters' ) and the Level of Detail to determine the simplified model (see
Chapter 'Edit Model' ).
For an effective and fast calculation, RWIND Simulation applies a parallel approach by using the
cores of your computer in an optimal way. You can check on those calculation settings in the Program
Options dialog box which you can access on the Options menu.
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Figure 4.7

4.1.4

Program Options dialog box, Program tab

Troubleshooting

Although OpenFOAM® computational modules are stable and have been verified by thousands of
users over the past 15 years, it should be remembered that simulations of 3D turbulent flow are a nonlinear mathematical problem that does not always have to converge. In RWIND Simulation, we
consider the numerical solution to be correct when the pressure residual drops below 0.001. This
usually occurs within 500 iterations, but sometimes the calculation ends without reaching the desired
residual value. There may be a number of reasons for this and there is no universal solution, but we will
try to give at least some advice on how to proceed:
Use the Continue Calculation function with a greater number of maximum iterations to see if the
solution continues to converge or not.
Increase the external dimensions of the computational domain, i.e. the boundaries of the wind tunnel.
Automatically set dimensions may sometimes be insufficient, especially behind the model (i.e.
downstream).
Increase the density of the Finite Volume Mesh in the 'Simulation Parameters' dialog box
Level of detail for simplified models in the 'Edit Model' dialog box .

or the

Try to simplify and optimise the model:
If the model has holes (such as windows, doors, etc.) through which the flow can enter inside the
model, try closing those openings (assuming you do not want to deal with the flow inside the
model).
Remove small details in the model which have little or no influence on the simulation results.
Buildings should be placed correctly on floor of the wind tunnel or beneath this level. If the
model is placed above the tunnel floor with a thin empty space between the model and the
tunnel floor, the solution may crash.
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4.2

Calculation in RFEM/RSTAB
In the Simulate and Generate Wind Loads window of RFEM or RSTAB, you can start the calculation in
the Load Cases tab (see Chapter 'Load Cases' ). When you click the [Open in RWIND Simulation]
button, you call up the RWIND Simulation program. There you can check on the simulation
parameters, such as the shape of the simplified model, wind tunnel, etc. If all settings are accurate, you
can then start the calculation as described in Chapter 'Calculation' above.
The [Open in RWIND Simulation] function gives you a “backstage inspection” of the simulation. This
feature is recommended to calculate one load case in order to verify and calibrate the simulation
parameters, if necessary.
At the end of the calculation, you have to decide whether to close RWIND Simulation and return to
RFEM/RSTAB or continue studying the results in RWIND Simulation.

Figure 4.8

RWIND Simulation message after calculation

To launch the calculation without opening RWIND Simulation, use one of the [Calculate] functions.

Calculate All in Background
When you click this button, the “silent” calculation of all load cases by RWIND Simulation is started in
the background. For every load case, the progression of the simulation is shown in a panel.

Figure 4.9
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Calculating all in background
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The results are finally transferred to RFEM/RSTAB, and the RWIND Simulation panel is closed.

Calculate LC in Background
When you click this button, only the load case selected in the table is relevant for the simulation.
RWIND Simulation performs a “silent” calculation, too, but you can follow the progression of the
simulation in the panel.
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5
5.1

Results
Results in RWIND Simulation
The CFD results are displayed immediately after the calculation. If you do not want to quit RWIND
Simulation, select [No] for the question as seen in
Figure 'RWIND Simulation message after calculation' . You can then examine the results in RWIND
Simulation.
When RWIND Simulation was closed, the results of the project (model file) can be viewed again after
having opened it e.g. by using the Project Manager of RWIND Simulation (see
Chapter 'Project Management' ).

5.1.1

Types of Results

After the simulation, different types of results are available for evaluation. They can be accessed in the
Data navigator, on the Results menu, or in the panel by clicking the entry.

Figure 5.1
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Types of results available in navigator, on Results menu and in panel
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Viewing results on model
Use the scroll wheel of your mouse to move, rotate or zoom the model. When you press the wheel
button, you can move the model within the workspace. When you press both the wheel button and the
[Ctrl] key, you can rotate the model (alternatively, press the wheel button and hold down the right
mouse button). Zooming is possible by turning the wheel, as usual. The symbol of the pointer will
illustrate the selected function.

5.1.1.1

Figure 5.2

Surface Pressure

Surface pressure

By default, the pressure due to the wind acting on the surfaces is displayed as Color Map: to every
point on eachsurface, a pressure value is allocated. The colour assignment indicates thelocations in all
surfaces that have a specific pressure magnitude. In the panel, the colours and respective values are
represented.
The pressure acts perpendicularly on the surfaces, thus showing you drag (positive magnitudes) and lift
(negative magnitudes).
When you activate the Show Drag Forces option in the panel or navigator, you can review the
resulting force of the wind load acting on the model and its location.
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Figure 5.3

Surface pressure with resulting drag force

If required, you can modify the colours and assigned values (see Chapter 'Colour Map' ).
When you activate the Results on Finite Volume Mesh option in the panel or navigator, the surface
pressure results of the Finite Volume mesh used for the calculation are displayed. Thus, you can check
how e.g. holes or connections of beams are factually treated for the simulation.

Figure 5.4
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5.1.1.2

Figure 5.5

Pressure Field

Pressure field

The pressure field represents a section through the wind tunnel illustrating the wind pressure distribution
of the air flow. Drag is represented by positive magnitudes, lift by negative ones.
The section is presented in one of the global planes (XY, XZ, YZ) that is controlled by the respective
button in the Slicer Plane section of the panel. To evaluate pressure fields at specific sections on the
model, use the Slicer options described in Chapter 'Slicer' .

Figure 5.6
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Pressure field in horizontal slicer plane (XY)
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5.1.1.3

Figure 5.7

Velocity Field

Velocity field on simplified model (mesh faces and edges disabled)

The velocity field represents a section through the wind tunnel illustrating the wind speed distribution. It
enables you to evaluate the scalar field of wind velocity on your model.
The section is presented in one of the global planes (XY, XZ, YZ) that is controlled by the respective
button in the Slicer Plane section of the panel. To evaluate velocity fields at specific sections on the
model, use the Slicer options described in Chapter 'Slicer' .
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5.1.1.4

Figure 5.8

Velocity Vectors

Velocity vectors

The velocity vectors within a slicer plane represent a collection of arrows featuring specific magnitudes
and directions. The arrows are attached to discrete grid points in the plane. By the velocity vectors, you
can evaluate both the wind speed and the direction of air flow around the model.
To display velocity vectors at specific sections on the model, use the Slicer options described in
Chapter 'Slicer' .
The View navigator provides three options for you to modify the vector display: Line (shows or hides
vector lines), Arrow Head (shows or hides vector heads), Uniform Size (scales or levels vectors). If the
latter option is disabled, the arrow lengths and thicknesses of heads reflect the magnitudes of each
wind velocity.

Figure 5.9
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Velocity vectors featuring option Uniform Size disabled
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5.1.1.5

Figure 5.10

Streamlines

Streamlines

Streamlines are a fine tool to study the characteristics of the air flow. They represent a composition of
curves that are tangent to the velocity vector (see above), showing the direction in which a massless
fluid element will travel at any point in time (see explanation at
https://www.grc.nasa.gov/WWW/k-12/airplane/stream.html ).
The colours visualise the speed of the particles moving through the wind tunnel. The associated
velocities are explained in the panel.
For a vivid visualisation of the air flow, activate the Streamlines Animation in the panel or on the Results
menu. You can then watch the fluid particles flowing around the model and examine their speeds and
directions.
The graphical settings of the streamlines are controlled in a separate section of the panel. You can
access it by clicking Streamlines Settings in the panel or on the Options menu, pointing to Streamlines.

www.dlubal.com

61

5

Results

RWIND Simulation - User Manual

Figure 5.11

Streamlines Settings in panel

Control Points Source
The streamlines are referred to control points that are created automatically. You can modify the
number of points by the slider.
By default, the control points are located within a 3D Box. It is possible to select a different type of
source from the list (see image to the left), but those options are only relevant for specific evaluations.
When the Show Manipulator option is enabled, you can change the size and location of the 3D box
graphically in the work window. The functionality of the arrows corresponds to the features to modify
the wind tunnel (see Chapter 'Wind Tunnel' ). Click [Apply] to transfer the new settings.

Particle Animation
Use the Animation option to switch on or off the display of the animated view of the streamlines in the
work window.
By default, the flow of the particles is displayed as Lines. When you select the Particles option from the
list, you can examine the direction and speed of the particles around the model.
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Figure 5.12

Particles animation type

To modify the settings of the animated streamlines, click the [Animation options] button. Alternatively,
select Streamlines Options on the Options menu, pointing to Streamlines. The following dialog box is
opened.

Figure 5.13

Streamlines Options dialog box

Streamlines
The Display streamlines when animating movement of particles option controls whether the lines are
shown when the Particle type of animation has been selected (see above). Furthermore, it is possible to
increase the Line thickness of the streamlines display. The Calculation of streamlines is effectuated both
Downstream and Upstream by default. The former option enables you e.g. to visualise effects of drag,
the latter to display lift in detail.
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Animation of Particles and Flowlines
In this section of the dialog box, you can control the Count (number), Size (thickness), Length, or Speed
of the particles and streamlines utilised for the animated display. Use the slider to increase or reduce
the single parameters.
Click [Apply] to review modified settings in the animated view without closing the dialog box.

5.1.1.6

Figure 5.14

Member Forces

Member forces

With this option, you can examine the forces acting on the members of the model. Each arrow reflects
the size and direction of the force determined for the specific location along the member. The
representation of the forces is without values.
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5.1.1.7

Figure 5.15

Residual Pressure

Chart showing residual pressure

During the calculation, the diagram of the residual pressure is shown (see
Figure 'Diagram of iterations and residual pressure' ). It is a logarithmic chart which is also available
after the calculation for inspection.
The residual pressure illustrates the progress of the applied pressure during the iterative simulation
process. Starting from an initial value of the pressure, the simulation refines the residuals with every
iteration, trying to reduce the imbalance of the pressure in the finite volume. The lower the residuals
become, the more accurate the solution will be. The simulation terminates when the convergence
criterion has been reached (or the maximum number of iterations is used up). Thus, the residual
pressure represents an important tool to judge the convergence of the simulation.
You can control the iterative calculation by the settings in the Simulation Parameters dialog box (see
Chapter 'Simulation Parameters' ).
To resize the Chart of residuals and iterations, move the window frames accordingly.
Use the [Print] button to print the diagram. The Windows Print dialog box appears where you can
specify the printer and its settings.
When you click the [Edit] button, the Chart Settings dialog box is opened. There you can adjust the
layout of the Curves, for example.
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Figure 5.16

Chart Settings dialog box to modify layout of Curves

If the Residual Pressure diagram reveals any problem concerning convergence, you should review the
Simulation Parameters (mesh density, convergence criterion) and the Wind Tunnel . For the latter,
the default size is set as small as possible to obtain short calculating times. If its length in X-direction is
too short (especially the area behind the object), effects of divergence and, thus, oscillating values of
residual pressure may arise. In that case, extend the wind tunnel accordingly. For more details, see
Chapter 'Troubelshooting' .

5.1.1.8

Figure 5.17
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Sums of Drag Forces

Drag force sums of original and simplified models
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In the lower part of the graphical window, the Legend indicates the check sums of the drag forces.
They represent the resultants of the wind load in the global directions X, Y, and Z. You can compare
the drag forces acting on the Original Model and on the Simplified Model. If there are considerable
differences, you ought to increase the level of detail in the Edit Model dialog box for a more refined
simplified model (see Chapter 'General' ).

5.1.2

Slicer

All scalar field results, such as Pressure Field and Velocity Field , as well as the Velocity Vectors
are displayed in a Slicer plane. It represents a planar section through the air flow within the wind
tunnel.

Figure 5.18

Slicer plane showing pressure field results

By default, the slicer plane is located in the centre of the wind tunnel and aligned parallel to one of the
global planes (XY, XZ, YZ). You can change the plane by clicking the corresponding button in the
Slicer Plane section of the panel.
To move the slicer to a different position, use one of the four bullets shown in the corners of the slicer
plane (Slicer Plane Handle). When you pull the plane along a wind tunnel line, the results are
dynamically updated for the new slicer plane.
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If you need an inclined plane to evaluate the results, select the Clipper tab of the panel. Either define
the Rotation about the relevant axis manually in the corresponding panel section, or select the Show
manipulator option in the Clipper Settings section to adjust the plane graphically.

Figure 5.19

Slicer plane showing velocity field results for surface non-parallel to global plane, Clipper tab with options to adjust slicer

Use the arcs shown in the slicer centre to rotate the plane about its longitudinal or transversal axis. The
corresponding angle is updated in the panel.
Activate the Cascade option in the Slicer Options section of the panel to create a group of parallel
planes (“slices”) within the wind tunnel. You can define the distance between each by clicking the
[Options] button. Alternatively use the Slicer Options on the Options menu to open the corresponding
dialog box.

Figure 5.20

Slicer Options dialog box

In the Slicer Cascade section, you can define the unit distance between each parallel plane by an
Absolute value or a Relative parameter (the effective distances are controlled in the Clipper tab by
means of the Step factors).
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The Option section controls the maximum number of parallel planes. It is a global setting which is
applied to all projects.

Figure 5.21
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Cascade of slicer planes
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5.1.3

Display Options

RWIND Simulation provides several features for you to control the graphical user interface and to
specifically evaluate the results.

5.1.3.1

Graphical User Interface

The display options control how objects are displayed in general: colour and layout of lines, font of
numbering, etc. In the View navigator, however, you decide whether single objects are shown or not.
On the Options menu, point to Display Options and select Edit to open the following dialog box.

Figure 5.22

Display Option dialog box

Select the relevant object in the Category tree. In the Parameters section, you can then adjust the
colour, line type, font of numbering, etc. The parameters depend on the selected item.
As the settings are managed separately for the Screen and Printer, you can define specific adjustments
for the work window and for your documentation.
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5.1.3.2

Scalar Fields

By the Scalar Fields options available in the View navigator, you can display the results values
associated to every point of the model in different ways. Alternatively, select the display option from
the list button in the toolbar. Please note that the type of display must match the type of result: For
example, isosurfaces representing 3D finite volume mesh results cannot be applied to the 2D surface
pressure results.

Figure 5.23

Color Map display of surface pressure

The Color Map display option is set by default. It fits all types of results and model display as it is
adapted automatically. In the panel, the eleven principal colours with the corresponding values are
represented. You can adjust both colours and values, if necessary (see Chapter 'Colour Map' ).
Isolines represent lines of points with equal results. By default, eleven colours are allocated to lines
featuring values at equidistant intervals. Isolines can be useful for printing graphics to a monochrome
printer.
Isosurfaces are surfaces featuring identical values of the 3D finite volume mesh output. That option can
be used to display pressure field and velocity field results.
The Color Edges and Color Points options illustrate the results of the 3D finite volume mesh. Thus, they
are useful to display the pressure field and velocity field results by coloured mesh lines or coloured
mesh nodes, respectively.
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Figure 5.24

Color Edges display of velocity field

If the Min/Max Values option is enabled, the extreme values of the selected type of result are
indicated. Ordinary values can be displayed by moving the pointer across a surface or within the slicer
plane (make sure that the Show Values Under Cursor option is selected in the panel).
Depending on the selected type of results, the Solid/Transparent Model view or the Wireframe Model
view is advantageous to evaluate the results. You can also select the model display option from the list
button in the toolbar.

Figure 5.25
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Color Points display of pressure field for Wireframe Model
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5.1.3.3

Clipper

Sections on the model can be created by means of a Slicer or a Clipper. In the latter, the zone
behind (or in front of) the cutting plane is included in the view. Select the Clipper option in the Clipper
Settings section of the panel to activate it. The clipper is only available for 3D finite volume mesh
output, such as pressure field or velocity field results.

Figure 5.26

Results in Clipper display

The settings options of the Clipper tab correspond to those of the Slicer . You can also modify the
clipper box graphically via one of the four bullets shown in the corners of the section plane. When you
pull the clipper plane along a wind tunnel line, the results are dynamically updated.
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5.1.3.4

Colour Map

The Edit Bar tab of the panel includes a colour scale with assigned ranges of values. Eleven colour
zones are set by default. They cover the range between the minimum and the maximum values in equal
intervals.
To adjust the colour scale, double-click one of the colours. You can also use the shortcut menu of the
colour scale where you select Edit Scale and Colors.

Figure 5.27

Edit Color Scale dialog box

Use the vertical sliders to the right of the values to reduce the number of colour ranges at both ends of
the colour scale. To change a specific colour, double-click it. Then select a different colour in the
familiar Colour dialog box.
You can adjust scale values individually, but make sure that you follow an ascending or descending
order. The buttons in the Permanent Scales section assist you to assign values automatically and save
the new settings for other projects.
By increasing the values in the Number of Intermediate Isolines section, you can obtain a more refined
output of isolines or separation lines.

74

www.dlubal.com

5

Results

RWIND Simulation - User Manual

5.1.3.5

Named Views

You can save and import user-defined views featuring specific viewing angles, zoom factors or specific
items selected in the View navigator. Those so-called Named Views make it easier for you to evaluate
the results. They correspond to the “User-defined views” of RFEM/RSTAB as described in
Chapter 9.9.1 of the RFEM manual .
To store the present view of the model or simulation, select Save Current View on the View menu.

Figure 5.28

Saving current view

Enter a View Name to denote the current display settings and click [OK] to save the view.
To restore the specific settings of a specific view, select Edit Named Views on the View menu.

Figure 5.29

Edit Named Views dialog box

Activate the Display selected option and then select the relevant view in the Saved Views section.
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5.1.3.6

Reduced Domain

For large models, it can be difficult to graphically evaluate the results associated with specific
locations. The Show Reduced Domain option enables you to view the results of a limited area within
the wind tunnel. Activate this feature in the Display Options of the panel where you can also access the
settings.

Figure 5.30

Displaying results of reduced domain

This option is available for all types of results except for surface pressure. As an effect,the graphical
output is reduced to relevant parts of the model.
To adjust the size of the reduced domain box, select the Edit Reduced Domain option in the Results
section of the panel. You can then modify the dimensions in the panel which offers the corresponding
options. Alternatively, use the arrows displayed within the domain box to resize it. The functionality
corresponds to the features described in Chapter 'Wind Tunnel' : when you hold the [Shift] key while
moving an arrow, the box is modified symmetrically in the respective direction. By holding the [Ctrl]
key, you can scale the area up or down uniformly in all three directions.
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Figure 5.31

5.1.4

Modifying reduced domain

Units and Decimals

To adjust the units or the decimal places displayed, select Units on the Options menu.

Figure 5.32

Edit Units dialog box

Select the Current unit box of the unit you want to modify. Then use the button to open the list of
available units. Additionally, you can reduce or increase the number of Dec. places by entering a
different value.
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5.1.5

Grid and Work Plane

Grid points are useful when defining objects graphically. To open the settings of the grid, select Grid
and Work Plane on the Tools menu. Alternatively, use the
toolbar button.

Figure 5.33

Grid and Work Plane dialog box

The Work Plane can be parallel with one of the three global planes: XY, YZ, or XZ (the selection is also
possible by the toolbar buttons, i.e. without opening this dialog box).
By default, the Grid Origin is in the zero point. Use the
button to select a different point in the work
window, or enter its coordinates. With the
button, you can define a new point for reference.
In the sections below, specific options are available for you to adjust the Grid Type (cartesian or polar
arrangement), Number of Grid Points and Grid Point Spacing, for example.
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5.1.6

Printing Graphics

You can print every image that is currently shown in the work window.

Print Preview
Before printing the image to the printer or clipboard, you should check the preview. Select Print
Preview on the File menu to open a different window.

Figure 5.34

Preview window

The preview shows the current view of the work window, the colour scale, and the legend.
Use the [Options] button to open a dialog box where you can control specific settings for printing. This
dialog box can also be accessed by selecting Print Options on the File menu.

Figure 5.35
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In the first tab, you can control the contents of the Print, the Page Orientation, and the Page Margins.

Figure 5.36

Print Options dialog box, Picture tab

The second tab controls the settings of the Print Quality (resolution), Colors and Frame (texts and lines
optionally in black for monochrome printers), Text Size (scaling factor if fonts are too small or too big),
as well as of the Symbol Size and Line Width (scaling factor for graphical objects). In most cases, it is
not necessary to change the default settings.
Please note that resolutions higher than 5000 x 5000 pixels together with a 32-bit colour depth may
result in data exceeding 100 MB, which is a problem to some printer drivers.

Figure 5.37

Print Options dialog box, Color Scale tab

In this tab, you can control the Orientation of the colour scale, the Drawing Options (frame, min-/max
info) and its Size as well as its Position (inside or outside of image, alignment, font).
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Figure 5.38

Print Options dialog box, Legend tab

In the final tab, you can activate up to four Legend Rows and allocate texts. The project information
and picture description are set by default. You can select different content from the list or insert
user-defined text, if necessary.
To review the modified settings, click [Apply]. If the Print Options are adequate, close the dialog box.
Then use the [Print] button in the toolbar of the preview window to start printing.

Print
To start the printing process, select Print on the File menu or use the

button in the toolbar.

The Windows Print dialog box is opened.

Figure 5.39

Print dialog box

Select the Printer and define the Properties, if necessary. [OK] starts the print.
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5.2

Results in RFEM/RSTAB
The Simulate and Generate Wind Loads window does not provide any results of the simulation. It
manages the data that are relevant for the input only. The output of the analysis effectuated by RWIND
Simulation is converted to loads which are then allocated to the respective load cases of RFEM or
RSTAB.
To access the results of the simulation in the main program, close the Simulate and Generate Wind
Loads window by clicking [OK].

5.2.1

Load Cases

In RFEM and RSTAB, select one of the load cases created by RWIND Simulation by the following
options:
Data navigator: Load Cases and Combinations

Load Cases

Toolbar: list of load cases
Table: 2.1 Load Cases
Menu: Edit

Figure 5.40

Load Cases and Combinations

Load Cases

RWIND Simulation load cases in navigator, toolbar, and table

The descriptions of the RWIND Simulation load cases (“Wind x °”) reflect the ones defined in the
Load Cases tab of the Simulate and Generate Wind Loads window (see Chapter 'Load Cases' ).
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5.2.2

Loads

The loads that were generated by RWIND Simulation are displayed as nodal loads and/or member
loads on the model. The numerical values are managed in Table 3.1 Nodal Loads exported from
RWIND Simulation and Table 3.2 Member Loads. When you double-click a load arrow in the
graphics, the corresponding Edit Load dialog box is opened.
It is not possible to modify any load value which is based on the analysis by RWIND Simulation.

Figure 5.41
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5.2.2.1

Figure 5.42

Nodal Loads

RWIND Simulation nodal loads in Data navigator, work window, and Table 3.1 Nodal Loads exported from RWIND Simulation

For the surfaces of the model, nodal loads are created for all nodes of the FE mesh. Each load vector
is defined By components of its forces acting in the global XYZ-directions. The values of the constituent
forces PX, PY, and PZ are shown in the graphics, dialog box, and table.
Even for ordinary mesh sizes, a great number of loads is created at rather close distances. You can
disable the load values display via the
button for a better view of the vectors. If necessary, you can
also adjust the scaling of the arrows in the Display Properties. This option is described in
Chapter 11.1.2 of the RFEM manual .
To evaluate the loads of an RWIND Simulation load case for parts of the model in better clarity, you
can use the Visibilities (see Chapter 9.9.1.2 of the RFEM manual ).
When the FE mesh is deleted or modified, the nodal loads imported from RWIND Simulation will be
deleted.
When you have used the Close holes option to fill openings for the simulation (see
Section 'Model Properties' ), please note that the loads acting on the closed parts of the model in
RWIND Simulation are not represented as nodal loads in RFEM. There is no algorithm which could
redistribute those loads on the parts around the openings.
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5.2.2.2

Figure 5.43

Member Loads

RWIND Simulation member loads in Data navigator, work window, and Table 3.2 Member Loads

For the members of the model, concentrated, uniform or trapezoidal member loads are created,
depending on the specification in the Settings tab. The Figure above illustrates the results of a
uniform distribution. If the concentrated load distribution was set, many loads are created at close
relative distances along every member, depending on the density of the mesh.
The load values being rather small in most cases, they can be distinguished by increasing the number
of decimals or changing the forces unit to [N], for example. Select Units and Decimal Places on the
Edit menu to open the dialog box familiar from RFEM/RSTAB.

Figure 5.44
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5.2.3

Types of Results

Load cases created by RWIND Simulation can be calculated in same manner as load cases containing
user-defined loads. For a detailed description of the calculation, see Chapter 7 of the RFEM manual .
After the calculation, the results are displayed graphically in the work window and listed numerically in
the tables.

Deformations and Internal Forces
Chapter 8 of the RFEM manual gives an overview of the different types of results. The evaluation of
the results is described in Chapter 9 of the RFEM manual . Use the Results navigator or the toolbar
buttons to display the deformations of surfaces and members or to select specific internal forces of
surfaces or members.

Figure 5.45

Deformations of a load case containing RWIND Simulation loads

You can verify the plausibility of the applied wind loads by checking the global deformations, for
example. Table 4.0 Results - Summary gives you an overview of the sums of loads and support forces
as well as of the global resultants (see Figure above ).
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Distribution of Loads
The Results navigator provides one specific option for you to evaluate the results of RWIND Simulation
loads: Activate the Distribution of load results and then select the Wind load using RWIND Simulation
item.

Figure 5.46

Distribution of load showing local forces fz in [kN/m2] perpendicular to surfaces

As described in Chapter 9.3.2 of the RFEM manual , the distribution of the forces on the finite
elements is displayed which results from the defined loads. You can select the forces acting in one of
the Global directions (X, Y, Z) or Local directions of the surfaces (x, y, z). By displaying the RWIND
Simulation surface loads, you can adequately evaluate the results of the simulation.
Note that this feature is applicable for FE results of surfaces or solids only, not for members.
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5.2.4

Load Combinations and Result Combinations

You can combine RWIND Simulation load cases with common load cases within load combinations
and result combinations. The former incorporate the loads of the contained load cases, the latter of the
results. For a detailed description, see Chapter 5 of the RFEM manual .

Figure 5.47

Edit Load Cases and Combinations dialog box, Actions tab with load cases generated by RWIND Simulation

RWIND Simulation load cases are classified as alternatively acting in the Wind action category. Wind
load cases never occur in two directions simultaneously.
Note that wind load cases usually only coexist with self-weight. If the separate calculation of an
RWIND Simulation load case gives an instability, combine it with the self-weight load case.
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5.2.5

Print

In the global printout report of RFEM or RSTAB, the input data of RWIND Simulation is not managed
specifically. The generated load cases with their loads are transferred to RFEM/RSTAB where they can
be integrated into the documentation. In the same manner, the results of every RWIND Simulation load
case can be prepared for the printout report. Chapter 10 of the RFEM manual gives you detailed
information on the printing options.

Figure 5.48
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